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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard,
flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP Mini 100e Education Edition

Processor Intel® Atom™ N455 1.66-GHz processor, 512-KB Level 2 cache

Chipset Intel NM10 Express

Graphics Intel® Graphics Media Accelerator 950

 Universal Memory Architecture (UMA) graphics subsystem

Display panel 25.65-cm (10.1-in) Wide Super VGA (WSVGA) 1024x600 LCD

Memory One customer-accessible/upgradable memory module slot (SODIMM 667-MHz,
DDR3)

 Supports up to 2 GB of system memory

 PC3-10600, 667-MHz, DDR3, shared

 Supports the following configurations:

 ● 1024-MB total system memory (1024 × 1)

 ● 2048-MB total system memory (2048 × 1)

Hard drive Supports 9.5-mm (0.37-in), 6.35-cm (2.5-in) parallel SATA hard drives

 160-GB, 5400-RPM

Optical drive Supports external USB optical drives only

Diskette drive Supports external USB diskette drives only

Audio/Visual High-definition (HD) audio

 Integrated monaural speaker

 Fixed integrated digital microphone

 Fixed integrated VGA webcam

Modem 56K data/fax modem

Ethernet Integrated Realtek RTL8105E-GR 10/100M network interface card (NIC)

Wireless WLAN antenna built into display assembly

 Integrated WLAN by way of 802.11b/g/n WLAN module
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Category Description

External media cards SD Card Reader supporting:

● MultiMediaCard (MMC)

● Secure Digital High Capacity (SDHC) Memory Card

Ports Audio-in (stereo microphone)

 Audio-out (headphone)

 RJ-45 (Ethernet, includes link and activity lights)

 2 USB 2.0 (1 powered)

 3-pin AC power

 VGA, supporting up to 1400x1050 external resolution @ 60Hz, hot plug/unplug,
and auto detection for correct output to wide-aspect vs. standard

Keyboard/pointing device 92% keyboard

 TouchPad, with 2 TouchPad buttons and 2-way scrolling (taps enabled as
default)

Power requirements 40-watt adapter, RC/V 2W

 AC adapter connector on cable

 6-cell lithium-ion (Li-ion) battery (2.2-Ah, 47-Wh)

 3-cell lithium-ion (Li-ion) battery (2.55-Ah, 28-Wh)

Security Security cable slot

Operating system Preinstalled:

 Windows® XP Home SP3

 Windows 7 Starter (Basic)

 Novel SuSE Linux Enterprise Desktop (SLED) 11

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Keyboard

 Memory module
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2 External component identification

Top
Top cover

Component Description

Network light Off: All network functions are off.

On: The computer is connected to a wired network or an
integrated wireless device, such as a wireless local area
network (WLAN) device, is on.
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TouchPad

Component Description

(1) TouchPad off indicator Turns the TouchPad on and off. Quickly double-tap the
TouchPad off indicator to turn the TouchPad on and off.

(2)  TouchPad zone Moves the pointer and selects or activates items on the
screen.

(3)  Left TouchPad button Functions like the left button on an external mouse.

(4)  Right TouchPad button Functions like the right button on an external mouse.
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Lights

Component Description

(1)  TouchPad off indicator ● On: The TouchPad is off.

● Off: The TouchPad is on.

(2)  Caps lock light ● On: Caps lock is on.

● Off: Caps lock is off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep, Standby, or
Suspend state.

● Off: The computer is off or in Hibernation.

(4) Mute light ● On: Computer sound is off.

● Off: Computer sound is on.

(5) Wireless light ● Off: All wireless devices are off.

● On: An integrated wireless device, such as a wireless
local area network (WLAN) device, is on.
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Keys

Component Description

(1)  fn key Executes frequently used system functions when pressed
in combination with a function key.

(2) Windows logo key Displays the Windows Start menu.

(3) Windows applications key Displays a shortcut menu for items beneath the pointer.

(4)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Power button

Component Description

Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep (Windows) or Suspend (Linux).

● When the computer is in the Sleep or Suspend state,
press the button briefly to exit Sleep or Suspend.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power Options,
or refer to the HP Notebook Reference Guide (Windows) or
Computer > Control Center > System > Power
Management (Linux).
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Front

Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(2) Speaker Produces sound.
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Right side

Component Description

(1) Audio-out (headphone) jack Connects optional powered stereo speakers, headphones,
earbuds, a headset, or television audio.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speaker is disabled.

(2) Audio-in (microphone) jack Connects an optional external microphone.

(3)  SD Card Reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● Secure Digital High Capacity (SDHC) Card

(4) USB port Connects an optional USB device. When this port is the
only USB port in use, it functions as a powered USB port.

(5)  Network activity light Blinking amber: Data is being transmitted over the network.

(6) RJ-45 (network) jack Connects a network cable.

(7)  Network connection light Green: The computer is connected to the network.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left side

Component Description

(1)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) Power connector Connects an AC adapter.

(3)  Battery light ● Off: The computer is running on battery power.

● Amber: The battery has reached a low or critical level
or there is a battery error.

● White: The computer is connected to external power
and the battery is charged.

(4) External monitor port Connects an external VGA monitor or projector.

(5) USB port Connects an optional USB device. When this port is the
only USB port in use, it functions as a powered USB port.

(6) RJ-11 (modem) jack Connects an optional modem cable.
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Display

Component Description

(1) Internal microphone Records sound.

(2) Webcam light On: The webcam is in use.

(3) Webcam Records video and captures still photographs.
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Bottom

Component Description

(1)  Computer handle (select models only) Allows you to carry the computer.

CAUTION: To reduce the risk of damaging the computer,
close the computer before picking it up by the handle.

(2)  Service access cover Provides access to the hard drive bay, a memory module
slot, and the wireless local area network (WLAN) module.

(3) Battery locking latch Locks the battery into the battery bay.

(4)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) Battery release latch Releases the battery from the battery bay.

(6)  Battery bay Holds the battery.
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Wireless antenna

Component Description

WLAN antenna* Sends and receives wireless signals to communicate with wireless
local area networks (WLAN).

*The antenna is not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antenna free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.

Wireless antenna 13



3 Illustrated parts catalog

Serial number label location
When you order parts or request information, the serial number label, affixed to the bottom of the
computer, provides important information that you may need when contacting technical support.

NOTE: The serial number label may vary according to model.

 Component Description

(1) Part number The number that provides specific information about the product's hardware
components. The part number helps a service technician to determine what
components and parts are needed.

(2) Serial number An alphanumeric number that is unique to each product.

(3) Product name The product name affixed to the front of your computer.

(4) Warranty period The duration of the warranty period for this computer.
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Computer major components
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Item Description Spare part number

(1) Display panel—25.65-cm (10.1-in) Wide Super VGA (WSVGA) 1024x600 LCD

See Display assembly components on page 18 for a comprehensive list of display
assembly spare parts.

615968-001

(2) Keyboard

 ● For use in Brazil 615967-201

 ● For use in France 615967-051

 ● For use in French Canada 615967-121

 ● For use in Germany 615967-041

 ● For use in Italy 615967-061

 ● For use in Latin America 615967-161

 ● For use in Portugal 615967-131

 ● For use in Spain 615967-071

 ● For use in Thailand 615967-281

 ● For use in the United Kingdom 615967-031

 ● For use in the United States 615967-001

(3) Handle

NOTE: The handle is included in the Handle Kit, spare part number 615966-001.

 

(4) Handle bracket 

NOTE: The handle bracket is included in the Handle Kit, spare part number 615966-001.

 

(5) Top cover (includes TouchPad and security cable bracket) 615965-001

(6) Security cable slot bracket (included in the top cover kit, spare part number
615965-001)

 

(7) TouchPad buttons (includesTouchPad board and cables) 619572-001

(8) Base enclosure  

 For models with a handle 615960-001

 For models without a handle 626121-001

(9) Speaker 619573-001

(10) Memory module (PC3-10600, 667-MHz, DDR3, shared)  

 1-GB 621563-001

 2-GB 621567-001

(11) RTC battery 619570-001

(12) Hard drive (160-GB, 5400-RPM)

NOTE: The hard drive spare part kit includes a bracket, screws, grommets, and Mylar
tape.

See Mass storage devices on page 20 for a comprehensive list of hard drive spare parts.

621406-001
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Item Description Spare part number

(13) WLAN module (4312 802.11b/g/n) 625054-001

(14) Modem cable

NOTE: The modem cable is included in the Cable Kit, spare part number 615961-001.

 

 Fan and heat sink assembly (includes replacement thermal material) 619576-001

(15) Heat sink assembly

(16) Fan

(17) System board (includes Intel Atom N455, 1.66-GHz processor, 512-KB L2 cache, and
replacement thermal material)

615969-001

(18) Modem 620340-001

(19) Power connector (includes cable)

NOTE: The power connector is included in the base enclosure, spare part number
615960-001.

(20) Battery  

 6-cell lithium-ion (Li-ion) battery (2.2-Ah, 47-Wh) 611708-001

 3-cell lithium-ion (Li-ion) battery (2.55-Ah, 28-Wh) 611707-001

(21) Service access cover

NOTE: The service access cover is included in the Plastics Kit, spare part number
619575-001 (for use in all countries and regions except Brazil) and spare part number
627093-001 (for use only in Brazil).
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Display assembly components

Item Description Spare part number

(1) Display bezel 619578-001
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Item Description Spare part number

(2) Webcam module 622745-001

(3) Display Hinge Kit (Includes left and right display panel hinges, brackets, and screws) 619574-001

(4) Display panel—25.65-cm (10.1-in) Wide Super VGA (WSVGA) 1024x600 LCD 615968-001

(5) Display cable (included in the Cable Kit, spare part number 615961-001)

(6) WLAN antenna and cable (included in the Cable Kit, spare part number 615961-001)  

(7) Display back cover (includes logo and shielding)  

 For models with a handle 619577-001

 For models without a handle (not illustrated) 626122-001
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Mass storage devices

NOTE: The hard drive spare part kit includes a bracket, screws, grommets, and Mylar tape.

Item Description Spare part number

(1) Hard drive connector 619571-001

(2) Hard drive (160-GB, 5400-RPM) 621406-001

(3) Grommets (included in the hard drive kit)

(4) Bracket (included in the hard drive kit)
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Miscellaneous parts
Description Spare part number

40-watt adapter, RC/V 2W 609949-001

Power cords

For use in Brazil 490371-201

For use in Europe 490371-021

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in The People's Republic of China 490371-AA1

For use in Singapore and the United Kingdom 490371-031

For use in South Korea 490371-AD1

For use in Taiwan 490371-AB1

Cable Kit (includes LCD display cable, webcam cable, modem cable, wireless cable, RJ-11 cable,
and TouchPad cable)

615961-001

Rubber Kit (includes 4 LCD display bezel bumpers) 615963-001

Screw Kit 615962-001

56K modem 620340-001
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Sequential part number listing
Spare part
number

Description

490371-001 Power cord for use in North America

490371-021 Power cord for use in Europe

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in The People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

609949-001 40-watt adapter RC/V 2W

611707-001 3-cell lithium-ion (Li-ion) battery (2.55-Ah, 28-Wh)

611708-001 6-cell lithium-ion (Li-ion) battery (2.2-Ah, 47-Wh)

615960-001 Base enclosure (for models with a handle)

615961-001 Cable Kit (includes LCD display cable, webcam cable, modem cable, wireless cable, RJ-11 cable, and
TouchPad cable)

615962-001 Screw Kit

615963-001 Rubber Kit (includes 4 LCD display bezel bumpers)

615965-001 Top cover (includes TouchPad and security cable slot bracket)

615966-001 Handle Kit (includes bracket and screws) (10 Handle Kits per package)

615967-001 Keyboard for use in the United States

615967-031 Keyboard for use in the United Kingdom

615967-041 Keyboard for use in Germany

615967-051 Keyboard for use in France

615967-061 Keyboard for use in Italy

615967-071 Keyboard for use in Spain

615967-121 Keyboard for use in French Canada

615967-131 Keyboard for use in Portugal

615967-161 Keyboard for use in Latin America

615967-201 Keyboard for use in Brazil

615967-281 Keyboard for use in Thailand

615968-001 Display panel—25.65-cm (10.1-in) Wide Super VGA (WSVGA) 1024x600 LCD

615969-001 System board (includes Intel Atom N455, 1.66-GHz processor, 512-KB L2 cache, and replacement thermal
material)
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Spare part
number

Description

619570-001 RTC battery

619571-001 Hard drive connector

619572-001 TouchPad buttons (includes TouchPad board and cables)

619573-001 Speaker

619574-001 Display Hinge Kit (includes left and right display panel hinges, brackets, and screws)

619575-001 Plastics Kit (includes keyboard frame and service access cover for use in all countries and regions except
Brazil)

619576-001 Fan and heatsink assembly (includes thermal replacement material)

619577-001 Display back cover (for models with a handle)

619578-001 Display bezel

620340-001 56K modem

621406-001 160-GB, 5400-RPM hard drive

621563-001 1-GB memory module (PC3-10600, 667-MHz, DDR3, shared)

621567-001 2-GB memory module (PC3-10600, 667-MHz, DDR3, shared)

622745-001 Webcam module

625054-001 4312 802.11b/g/n WLAN module

626121-001 Base enclosure (for models without a handle)

626122-001 Display back cover (for models without a handle)

627093-001 Service access cover (for use in Brazil only)
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat flexible tool

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the device, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors
CAUTION: When servicing the device, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the device.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.
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Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the device, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the device. If you are unsure whether the device
is off or in Hibernation, turn the device on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the device when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 65 screws, in 9 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
When you order parts or request information, provide the computer serial number and model number
provided on the service tag, affixed to the bottom of the computer.

NOTE: The service tag label may vary according to model.

 Component Description

(1) Part number The number that provides specific information about the product's hardware
components. The part number helps a service technician to determine what
components and parts are needed.

(2) Serial number An alphanumeric number that is unique to each product.

(3) Product name The product name affixed to the front of your computer.

(4) Warranty period The duration of the warranty period for this computer.
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Battery

Description Spare part number

6-cell lithium-ion (Li-ion) battery (2.2-Ah, 47-Wh) 611708-001

3-cell lithium-ion (Li-ion) battery (2.55-Ah, 28-Wh) 611707-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work and initiate Hibernation or shut down the
computer through the operating system before removing the battery.

1. Turn the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery locking latch (1) to unlock the battery.

3. Slide the battery release latch (2) to release the battery from the computer.

4. Lift the inner edge (3) of the battery, and remove the battery from the computer.

Reverse this procedure to install the battery.
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Service access cover

Description Spare part number

Service access cover (included in the Plastics Kit)  

For use in all countries and regions except Brazil 619575-001

For use in Brazil 627093-001

Before removing the service access cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 30)

Remove the service access cover:

1. Remove the 2 Phillips 2.0x4.0 screws (1) that secure the service access cover to the computer.

2. Lift the service access cover (2) from the middle to release the tabs along the sides and top
edge, and then remove the service access cover.

Reverse this procedure to install the service access cover.
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Memory module

Description Spare part number

Memory module (PC3-10600, 667-MHz, DDR3, shared)  

1-GB 621563-001

2-GB 621567-001

The computer has one memory module slot, which contains either a 1-GB memory module or a 2-GB
memory module. If your computer has a 1-GB module, you can upgrade the capacity of the computer
by replacing the 1-GB module with a 2-GB module.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module to release the memory
module. (The memory module tilts up.)

CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch
the components on the memory module.
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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RTC battery

Description Spare part number

RTC battery 619570-001

Before removing the real-time clock (RTC) battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board.

NOTE: The RTC battery is secured to the system board with double-sided tape.

Reverse this procedure to install the RTC battery.
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WLAN module

Description Spare part number

802.11b/g/n WLAN module 625054-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the device by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

Remove the WLAN module:

1. Disconnect the wireless antenna cable (1) from the terminal on the WLAN module.

2. Remove the Phillips PM2.0×4.0 screw (2) that secures the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the device.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WLAN module.

Hard drive assembly
NOTE: The hard drive assembly spare part kit includes a bracket, screws, rubber grommets, and
Mylar tape.

Description Spare part number

Hard drive assembly (160-GB, 5400-RPM) 621406-001

Hard drive connector 619571-001

Before removing the hard drive assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

Remove the hard drive assembly:

1. Remove the 4 Phillips 2.0x5.0 screws (1) that secure the assembly to the computer.
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2. Use the Mylar tab (2) to pull the assembly straight up to disconnect it, and then remove the
assembly.

If it is necessary to replace the hard drive bracket, follow these steps:

1. Remove the 4 Phillips 3.0x3.0 screws (1) that secure the hard drive bracket to the hard drive.

2. Using the Mylar tab, lift the bracket (2) away from the hard drive.
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If it is necessary to replace the hard drive bracket grommets, remove the grommets from the hard
drive bracket.

If it is necessary to replace the hard drive connector, remove the hard drive connector from the hard
drive.

Reverse this procedure to install the hard drive assembly.

Keyboard

Description Spare part number

● For use in Brazil 615967-201

● For use in France 615967-051

● For use in French Canada 615967-121

● For use in Germany 615967-041

● For use in Italy 615967-061
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Description Spare part number

● For use in Latin America 615967-161

● For use in Portugal 615967-131

● For use in Spain 615967-071

● For use in Thailand 615967-281

● For use in the United Kingdom 615967-031

● For use in the United States 615967-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30).

b. Service access cover (see Service access cover on page 31)

Remove the keyboard:

1. Remove the 2 Phillips 2.0x5.5 screws that secure the keyboard to the computer.

2. Turn the computer right-side up, and then open the display as far as possible.
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3. Using a flexible tool, gently pry up the keyboard cover starting under the space bar (1) and then
along the outside edges of the keyboard to release the plastic tabs.

4. Remove the keyboard cover (2).

5. Lift up on the top edge of the keyboard and hold it at an angle.

6. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached.
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7. Disconnect the cable (2), and then remove the keyboard (3).

Reverse this procedure to install the keyboard.

Top cover

Description Spare part number

Top cover (includes TouchPad and security cable slot bracket) 615965-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30).

b. Service access cover (see Service access cover on page 31).

c. Keyboard (see Keyboard on page 38)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the 11 Phillips 2.0x5.5 screws (1) that secure the top cover to the base enclosure.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the zero insertion force (ZIF) connectors (1) to which the TouchPad and TouchPad
button cables are connected.

6. Remove the cables (2).

7. Remove the 2 Phillips PM2.0×5.5 screws (1) that secure the top cover to the base enclosure.
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8. Lift the top cover (2) straight up to remove it from the base enclosure.

If it is necessary to replace the TouchPad buttons, follow these steps:

NOTE: The TouchPad buttons and cables are available using spare part number 615967-001.

1. Remove the 2 Phillips 2.0x4.0 screws (1) that secure the TouchPad buttons to the top cover.

2. Remove the TouchPad buttons (2) from the top cover.

If it is necessary to replace the TouchPad cable, follow these steps:
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NOTE: The TouchPad cable is available in the Cable Kit, spare part number 615961-001. For more
information about the Cable Kit, see Miscellaneous parts on page 21.

1. Release the ZIF connector (1) to which the TouchPad cable is connected.

2. Disconnect the TouchPad cable (2) from the TouchPad.

If it is necessary to replace the security cable slot bracket, follow these steps:

NOTE: The security cable slot bracket is available in the top cover kit, spare part number
615965-001.

1. Remove the 2 Phillips 2.0x4.0 screws (1) that secure the security cable slot bracket to the top
cover.
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2. Remove the security cable slot bracket (2) from the top cover.

Reverse this procedure to reassemble and install the top cover.

Speaker

Description Spare part number

Speaker 619573-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. Keyboard (see Keyboard on page 38)

d. Top cover (see Top cover on page 41)
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Remove the speaker:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the 2 Phillips 2.0x5.5 screws (2) that secure the speaker to the base enclosure.

3. Remove the speaker (3) from the base enclosure.

Reverse this procedure to install the speaker.
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Display assembly

Description Spare part number

Display panel—25.65-cm (10.1-in) Wide Super VGA (WSVGA) 1024x600 LCD

See Display assembly components on page 18 for a comprehensive list of display assembly
spare parts.

615968-001

Display Hinge Kit (includes left and right display panel hinges, brackets, and screws) 619574-001

Speaker 619573-001

Display back cover (includes shielding)  

For models with a handle 619577-001

For models without a handle 626122-001

Display bezel 619578-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. Keyboard (see Keyboard on page 38)

d. Top cover (see Top cover on page 41)

Remove the display assembly:

1. Disconnect the display cable (1) from the system board.

2. Release the tape (2) securing the WLAN antenna.
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3. Remove the WLAN antenna from the routing channel (3) on the system board.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other device
components.

4. Remove the 2 Phillips 2.0×4.0 screws (1) and the Phillips 2.0x5.5 screw (2) that secure the
display assembly to the computer.

5. Remove the display assembly (3).
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6. If it is necessary to replace the rubber bumpers on the display bezel, pry them off with a flexible
tool and peel them away from the bezel. The rubber bumpers are available in the Rubber Kit,
spare part number 615963-001.

7. If it is necessary to replace the display bezel, follow these steps:

a. Flex the inside edges of the top (1), the left and right sides (2), and then the bottom (3) of
the display bezel, until the bezel disengages from the display back cover.

b. Remove the display bezel (4).
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8. If it is necessary to replace the webcam module, follow these steps:

a. Disconnect the webcam cable (1) from the webcam.

b. Remove the Phillips 2.0x3.0 screw (2) that secures the webcam module to the display back
cover.

c. Remove the webcam (3).

9. If it is necessary to replace the display panel, follow these steps:

a. Remove the 6 Phillips 2.5×5.0 screws (1) and the 2 Phillips 2.0x3.0 screws (2) that secure
the display panel to the display back cover.

b. Remove the display cable from the routing channel (3) on the back cover.
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c. Remove the display panel (4) from the display back cover.

10. If it is necessary to replace the display hinges, follow these steps:

a. Remove the 2 Phillips 2.0×2.0 screws (1) that secure each hinge to the display back cover.

b. Remove the hinges (2).

11. If it is necessary to replace the display panel cable, follow these steps:

a. Peel back the Mylar protection on the back of the display panel (1).
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b. Disconnect the display panel cable (2).

12. If it is necessary to replace the wireless antenna transceiver and cable, detach the cable from
the adhesive (1) that secures it to the display back cover, and then remove the cable (2).

Reverse this procedure to reassemble and install the display assembly.
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Handle (select models only)

Description Spare part number

Handle Kit (includes brackets and screws) (10 Handle Kits per package) 615966-001

Before removing the handle, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. Keyboard (see Keyboard on page 38)

d. Top cover (see Top cover on page 41)

e. Display assembly (see Display assembly on page 47)

Remove the handle:

1. Remove the 2 Phillips 2.0x9.0 screws (1) that secure the handle bracket and handle to the base
enclosure.

2. Remove the handle (2).
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3. Remove the Phillips 2.0×6.0 screw (1) that secures the handle bracket to the base enclosure.

4. Remove the handle bracket (2).

Reverse this procedure to install the handle.

System board

Description Spare part number

System board (includes Intel Atom N455, 1.66-GHz processor, 512-KB L2 cache, and
replacement thermal material)

615969-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. RTC battery (see RTC battery on page 34)

d. Memory module (see Memory module on page 32)

e. WLAN module (see WLAN module on page 35)
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f. Hard drive (see Hard drive assembly on page 36)

g. Keyboard (see Keyboard on page 38)

h. Top cover (see Top cover on page 41)

i. Display assembly (see Display assembly on page 47)

j. Speaker (see Speaker on page 45)

k. Handle (see Handle (select models only) on page 53)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 35)

● Memory module (see Memory module on page 32)

● RTC battery (see RTC battery on page 34)

● Fan and heat sink assembly (see Fan and heat sink assembly on page 59)

Remove the system board:

1. Disconnect the power connector from the system board on the bottom of the computer.

2. Remove the 4 Phillips 2.0x6.0 screws (1) that secure the system board to the base enclosure.

3. Place your fingers underneath the system board in the empty memory module slot (2) and gently
apply pressure to slightly flex the system board while lifting the left edge (3).
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4. Remove the system board (4).

Reverse this procedure to install the system board.

Modem

Description Spare part number

56K modem 620340-001

Before removing the modem, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. RTC battery (see RTC battery on page 34)

d. Memory module (see Memory module on page 32)

e. WLAN module (see WLAN module on page 35)

f. Hard drive (see Hard drive assembly on page 36)

56 Chapter 4   Removal and replacement procedures



g. Keyboard (see Keyboard on page 38)

h. Top cover (see Top cover on page 41)

i. Display assembly (see Display assembly on page 47)

j. Speaker (see Speaker on page 45)

k. Handle (see Handle (select models only) on page 53)

l. System board (see System board on page 54)

Remove the modem:

1. Disconnect the modem jack cable.

2. Remove the 2 Phillips 2.0×3.0 screws (1) that secure the modem to the system board.
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3. Remove the modem (2).

Reverse this procedure to install the modem.
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Fan and heat sink assembly

Description Spare part number

Fan and heat sink assembly (includes replacement thermal material) 619576-0011

Before removing the fan and heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 30)

b. Service access cover (see Service access cover on page 31)

c. RTC battery (see RTC battery on page 34)

d. Memory module (see Memory module on page 32)

e. WLAN module (see WLAN module on page 35)

f. Hard drive (see Hard drive assembly on page 36)

g. Keyboard (see Keyboard on page 38)

h. Top cover (see Top cover on page 41)

i. Display assembly (see Display assembly on page 47)

j. Speaker (see Speaker on page 45)

k. Handle (see Handle (select models only) on page 53)

l. System board (see System board on page 54)
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Remove the fan and heat sink assembly:

1. Disconnect the fan cable from the bottom of the system board.

2. Loosen the 3 captive Phillips 2.0x9.0 screws (1) that secure the heat sink to the system board.

NOTE: The screws are numbered 1 through 3. Follow this order when loosening the screws.

3. Remove the Phillips 2.0x2.5 screw (2) that secures the heat sink to the system board.
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4. Remove the heat sink assembly (3).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink
assembly and system board components, it may be necessary to move the heat sink assembly
from side to side to detach the assembly.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
assembly and the system board each time the heat sink assembly is removed. Thermal paste (1) is
used on the processor (2), and thermal tape (3) is used on the Northbridge chip (4). Replacement
thermal material is included with the heat sink assembly and system board spare part kits.

Reverse this procedure to install the fan and heat sink assembly.
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5 Setup Utility (BIOS)

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup
Utility includes settings for the types of peripherals installed, the startup sequence of the computer,
and the amount of system and extended memory.

CAUTION: Use extreme care when making changes in Setup Utility. Errors can prevent the
computer from operating properly.

Starting Setup Utility
� Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is

displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f10.

Using Setup Utility
Changing the language of Setup Utility

1. Start Setup Utility.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.

Navigating and selecting in Setup Utility
Setup Utility does not support the TouchPad. Navigation and selection are by keystroke.

● To choose a menu or a menu item, use the arrow keys.

● To choose an item in a list or to toggle a field—for example an Enable/Disable field—use either
the arrow keys or f5 and f6.

● To select an item, press enter.
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● To close a text box or return to the menu display, press esc.

● To display additional navigation and selection information while Setup Utility is open, press f1.

Displaying system information
1. Start Setup Utility.

2. Select the File menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

Restoring factory default settings in Setup Utility
1. Start Setup Utility.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

The Setup Utility factory settings take effect when the computer restarts.

NOTE: Your password, security, and language settings are not changed when you restore the
factory settings.

Exiting Setup Utility
● To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version
To determine whether the BIOS needs to be updated, you must compare the BIOS version
information to the version information of the available updates.

To determine the BIOS version on the computer (also known as ROM date and System BIOS), start
Setup Utility.

If the version information is not displayed, use the arrow keys to select the File menu. BIOS and other
system information is displayed.

To exit Setup Utility, use the arrow keys to select Exit > Exit Discarding Changes, and then press
enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access the page on the HP Web site that provides software for your computer.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. At the download area, follow these steps:

a. Identify the most current BIOS update. If it is later than the BIOS version currently installed
on your computer, make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth with handle 250.6 mm 9.87 in

Depth without handle 206 mm 8.11 in

Width 276 mm 10.87 in

Height 39.8 mm 1.57 in

Weight

10.1-in. LCD, equipped with a 3-cell battery, hard drive,
1-GB memory, WLAN module, and 1 wireless antenna

1.46 kg 3.2 lb

10.1-in. LCD, equipped with a 6-cell battery, hard drive,
1-GB memory, WLAN module, and 1 wireless antenna

1.57 kg 3.5 lb

Input power

Operating voltage 19.5 V dc @ 2.05 A 19.5 V dc @ 2.05 A

Operating current 1.58 A 1.58 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20° to 60°C -4 to 140° F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%

Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 to 10,000 ft

Nonoperating -15 m to 12,192 m -50 to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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25.65-cm (10.1-in), Wide Super VGA (WSVGA) display
specifications

 Metric U.S.

Dimensions

Height 23.44 cm 9.23 in

Width 25.65 cm 10.1 in

Diagonal 25.53 cm 10.05 in

Number of colors 262,144

Contrast ratio 500:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.2175 × 0.2088 mm

Format 1024x600

Configuration RGB vertical stripe

Backlight White LED

Viewing angle +/-45° horizontal, +20/-45° vertical (typical)
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Hard drive specifications
 160-GB*

Dimensions

Height 9.5 mm

Width 70 mm

Weight 93.5 g

Interface type SATA

Transfer rate 1175 MB/sec (maximum)

Security  ATA security

Seek times (typical read, including setting)

Single track 1 ms

Average 14 ms

Maximum 30 ms

Disc rotational speed 5400 rpm

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Select the section in this chapter that applies to the operating system installed on your computer.
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Windows 7 backup and recovery
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), or create system image discs. In case of system
failure, you can use the backup files to restore the contents of your computer.

Windows Backup and Restore provides the following options:

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Recovering individual files

● Restoring the computer to its factory state

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system image discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. Your initial and subsequent backups allow you to restore
your data and settings if a failure occurs.

You can back up your information to optical discs, using an external USB optical drive (purchased
separately), to an optional external hard drive, or to a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press shift+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.
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● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of external optical drive attached to your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external optical drive
attached to your computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup schedule and to create system image
discs.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.

Performing a recovery
In case of system failure or instability, the computer provides Windows Backup and Restore to
recover information you have previously backed up.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system image
discs you previously created (select models only), you may use the System Recovery disc that came
with the unit by inserting the System Recovery disc into an external optical drive and booting from the
external optical drive. You may need to change boot order via F10–setup to complete this operation.

NOTE: The use of optical discs requires an external USB optical drive (purchased separately).

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system image discs you
created immediately after setup, or the System Recovery disc that came with the unit, you must
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purchase a Windows 7 operating system DVD to reboot the computer and repair the operating
system. Make sure that your most recent backup (stored on discs or on an external drive) is easily
accessible. To order a Windows 7 operating system DVD, go to http://www.hp.com/support, select
your country or region, and then follow the on-screen instructions. You can also order the DVD by
calling technical support. For contact information, refer to the Worldwide Telephone Numbers booklet
included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes. Before rebooting, make sure you have changed the
legacy boot order in the F10 utility so that the USB CD-ROM drive is the first choice.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the external
optical drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows XP backup and recovery
To protect your information, back up files and folders regularly. In case of system failure, you can use
the backup files to restore your personal information.

Windows provides the following options:

● Creating restore points

● Restoring your system configuration to a previous state

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press shift+prt sc.

c. Open a word-processing document and click Edit > Paste.

The screen image is added to the document.

d. Save the document.

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

To create a system restore point, follow these steps:

1. Select Start > All Programs > Accessories > System Tools > System Restore.

2. Follow the on-screen instructions to create a restore point.

72 Chapter 7   Backup and recovery



Performing a recovery
In case of system failure or instability, you can use the System Recovery disc (included with your
computer) to recover your operating system and programs installed at the factory.

Restoring your computer to an earlier state
To restore the computer to an earlier state, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > System Restore.

The System Restore Wizard opens.

3. Click Next and select a restore point.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and
updates not installed by HP must be manually reinstalled. Personal files must be restored from a
backup.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer and boot from the external optical drive.

NOTE: The boot order may need to be changed via F10-Setup.

5. Follow the on-screen instructions to install the original factory image.
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Linux backup and recovery
Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state. Recovery works
from a dedicated recovery partition on the hard drive. This type of recovery restores the computer to
its factory condition without using recovery discs.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer from the partition, follow these steps:

1. If possible, back up all personal files.

2. Restart the computer.

3. Using the arrow keys, select Recovery, and then press enter.

4. Follow the on-screen instructions.

NOTE: If you are unable to boot (start up) your computer from the hard drive partition with the
primary operating system or from the recovery partition, you must purchase a SUSE Linux Enterprise
Desktop Operating System DVD to reinstall the operating system. For additional information, refer to
the Worldwide Telephone Numbers booklet.
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8 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-in (microphone) 75



Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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9 Power cord set requirements

The wide range input feature of the device permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the device meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the device is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the device.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display back cover.

6. Remove the display panel assembly (2) from the display back cover.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part

number 21
antenna, removal 52
audio, product description 1
audio-in (microphone) jack

identifying 9
pin assignments 75

audio-out (headphone) jack
identifying 9
pin assignments 76

B
backing up files 69
Backup and Restore 69, 70
base enclosure, spare part
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replacing 30
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battery bay, identifying 12
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buttons
left TouchPad 4
power 7
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C
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spare part number 21
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chipset, product description 1
components
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front 8
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right side 9
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wireless antenna 13
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D
default settings, restoring 63
device specifications 65
discs, Operating System 73
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precautions 25
product description 1

display assembly
removal 47
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removal 49
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graphics, product description 1
grounding equipment and

methods 28

H
handle

identifying 12
removal 53
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headphone (audio-out) jack
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pin assignments 76

heat sink
removal 59
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integrated webcam light,

identifying 11
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J
jacks
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audio-out (headphone) 9
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RJ-45 (network) 9
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keyboard

product description 2
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function 6
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product description 2
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packing guidelines 27
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plastic parts 24
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description 2
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product description 2
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power button, identifying 7
power connector
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set requirements 81
spare part number 21
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description 2
processor
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removal 54
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RJ-45 (network) jack
identifying 9
pin assignments 79

RTC battery
removal 34
spare part number 16, 34

Rubber Kit, spare part number 21

S
Screw Kit, spare part number 21
SD Card Reader, identifying 9
security cable slot

identifying 9
security cable slot bracket

removal 44
spare part number 16, 41

security cable slot, product
description 2

serial number label, location 14
service access cover

identifying 12
removal 31
spare part number 17, 31

service considerations 24
serviceability, product

description 2
Setup Utility

changing the language 62
displaying system

information 63
exiting 63
navigating 62
restoring default settings 63
selecting 62
starting 62
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speaker

identifying 8
illustrated 8, 47
removal 45
spare part number 45, 47

specifications
device 65
display 66
hard drive 67

static-shielding materials 28
system board

removal 54
spare part number 17, 54

system information, displaying 63

System Recovery disc 73

T
tools required 24
top cover

removal 41
spare part number 16, 41

TouchPad
identifying 4
illustrated 4
product description 2

TouchPad buttons
identifying 4
removal 43
spare part number 16

TouchPad cable, removal 43
TouchPad off indicator,

identifying 4
TouchPad zone, identifying 4
transporting guidelines 27

U
USB port

identifying 9, 10
pin assignments 80

V
vents, identifying 8, 10, 12

W
webcam light, identifying 11
webcam module

illustrated 19
removal 50
spare part number 19

webcam, identifying 11
Windows 7 operating system

DVD 70
Windows applications key,

identifying 6
Windows logo key, identifying 6
Windows recovery 73
wireless antenna

identifying 13
illustrated 13
removal 52

wireless light 5
WLAN module

product description 1
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